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ONLINE ASSISTANT PAGE ID 17817

Navigating FactSet 

FactSet allows you to analyze companies, view market data in real time, generate investment ideas, and manage your portfolios in a single, powerful platform. Your FactSet workspace consists 
of several tabs that feature the most relevant displays, reports, and applications based on your workflow. The following shows you tips for navigating your workspace.

Click the Search button to easily discover 
reports and applications without prior 
knowledge of where to find them on FactSet. 

• Pair concepts with identifiers (e.g., "apple chart ntm eps", "france gdp", "alibaba ipo") to find the most relevant application/
report to conduct your research and analysis

• Find answers to common financial data questions by entering a search term with an identifier or company to return data
directly in FactSet Search  (e.g., "fitbit ipo date")

• Navigate to any component in FactSet using a shortcut (e.g., “@PA” to launch Portfolio Analysis) or pair an identifier with the
shortcut (e.g., “IBM @PS” to launch the Price Summary with ticker IBM)

• Push just the identifier from your selected search result to your active tab by pressing CTRL+ENTER

For more information on search, see Online Assistant page 16233.

• Activate FactSet search: CTRL+SHIFT+F

• Find text within a component: CTRL+F

• Activate channel audit: ALT+I

• Revert to the last saved version of a tab: CTRL+R

• Save a workspace and document (i.e., settings): CTRL+S

• Toggle up/down through the tab layers: CTRL+Up Arrow
or CTRL+Down Arrow

• Move the cursor to the left or right in a tab layer:
CTRL+Left Arrow or CTRL+Right Arrow

• Navigate to the lowest tab layer: ALT+[1-9]

For a complete list, see Online Assistant page 15797.

Using FactSet Keyboard Shortcuts

Access shortcuts to your favorite FactSet components.  
Customize them using the Shortcut Manager.  For more 
details, see Online Assistant page 16162.

• Download a report in various formats (e.g., Excel, PDF)
based on the selected report.

• Save revisions to your current workspace.

• Read about the latest enhancements in Notify.

• Click to access help, eLearning, exchange 
entitlements, and more.  Select "About FactSet" to view
your FactSet username, serial number, and version.

Using the FactSet Toolbar

Click the Add Tab button to add new FactSet, 
template, or custom tabs, which allow you to 
personalize your workspace.

FactSet Search Tips
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Performing Company Analysis on FactSet 

The Company/Security tab provides a consistent, streamlined solution for finding everything you need to perform company analysis on FactSet within a single tab. It incorporates both public 
and private company data, as well as PE/VC investor and fund data. The reports are organized in the left pane by category and change based on your active identifier to provide only the 
information relevant to your research. For a demo featuring the Company/Security tab’s key functionality, go to Online Assistant page 17450.

Use the Back/Forward buttons 
to navigate through any reports 
you’ve previously selected within 
the Company/Security tab.

Automatically view any new 
company reports as they are 
created. Each is marked with a 
“New” indicator to easily identify 
the latest releases.

Access common features 
throughout the company reports, 
including the ability to click a 
report value to view additional 
details and launch related 
reports.

Summary of key Company/Security tab features:
• Allows you to easily discover existing reports within an intuitive, cleanly organized interface that

follows your company analysis workflow

• Automatically includes new reports that were previously unavailable and eliminates the need to
manually find and add each to your workspace

• Displays only relevant reports and data based on your active identifier

• Provides improved navigation, allowing you to seamlessly jump from one report to the next

Launch a second instance of the 
tab, download, print, or launch 
the context-sensitive help for the 
report you’ve selected.

Click section header links to 
see more information or view 
additional reports (e.g., click 
Price Volume to launch the Price 
Summary report).
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Screening for Ideas 

Idea Screening provides a workflow-driven, customizable application that allows you to screen for potential investment opportunities, find potential buyers, track trends, and identify precedent 
transactions.  For a guided tour of Idea Screening, launch the eLearning series on Online Assistant page 17315.

Click the View button to analyze 
results based on your screen's 
criteria.

Click the Adjust Logic button to 
edit the logic for your screening 
items and dynamically update 
counts based on your changes.

Drag parameters from the 
left pane to add them to your 
report.  Hover over the      icon 
to view the definition.  For more 
information on working with 
your screen parameters, see 
Online Assistant page 16697.

Search for keywords or filter 
results based on favorites or 
recommended items.

TIP > Read about the latest updates 
to Idea Screening in the "Screening" 
category of FactSet Notify. Click the 
category's envelope icon to receive 
email alerts.

View the number of transactions passing your 
screen, which automatically updates based on 
the parameters you specify.

Search to view a link directly 
to any passing results.  If a 
company/transaction doesn't 
pass, click the "Why?" link to find 
which of the parameters were 
not met.

TIPS > After running a screen, you can click a name 
and then select any of the next step reports to learn 
more about the company (e.g., Guide, Snapshot).

Also, click on any row and select “Add to Comps” 
to begin creating your own custom comps list.  For 
more information, see Online Assistant page 16699.

Select to save the screen, the 
report results, or the list of 
identifiers that passed your 
screen in order to use them in 
other applications.

Select to "Include undisclosed 
values" for relevant items.
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Using the FactSet 
Fundamentals database, 
click on data items to 
view a breakdown of the 
calculations and source link 
the value back to the filing.  
See Online Assistant page 
15775 for more information.

View growth and ratio data 
alongside actual data values for 
a company or compare company 
data to a related benchmark 
with the FactSet Fundamentals 
and FactSet Market Aggregates 
databases. See Online Assistant 
page 16770 for more details.

NOTE > Look for the 
"Preliminary" column to 
view intraday preliminary 
data available in FactSet 
Fundamentals. See Online 
Assistant page 16545 for more 
information.

Click the various subtabs within 
the selected Financials report 
to view the data organized in 
different ways.

TIP > Click the More Options 
button         at the top of 
the report for advanced 
report options, such as 
changing units, specifying 
LTM methodology, enabling/
disabling data auditing,  
showing sparklines, and 
enabling/disabling growth 
and ratio data in the report.

TIP > Read about the latest 
updates to financial reports 
in the "Company Analytics" 
category of FactSet Notify. Click 
the category's envelope icon to 
receive email alerts.

Use the options in the toolbar 
to launch another instance 
of the tab, download the 
report (including options to 
download as =FDS or Data 
Downloading codes), print, or 
launch help for the selected 
report in Online Assistant.

Viewing Company Financials 

You can research and audit company data for a given identifier with the financial reports on FactSet.  This page highlights the Key Items and Income Statement reports, but you can access 
additional financial reports, including the Balance Sheet, Cash Flow, Industry Metrics, Ratio Analysis, Use of Cash, and more. 

In the Income Statement, 
Balance Sheet, and Cash 
Flow reports, you can 
view both standardized 
and as-reported 
data from FactSet 
Fundamentals. See 
Online Assistant page 
14859 for more details 
on how to access as-
reported data.
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Accessing All Estimates and Broker Outlook 

The All Estimates report displays all consensus estimates, actuals, and guidance figures available on a variety of report periods for a given company. The Broker Outlook report provides an 
overview of broker research through an interactive chart with broker estimates; consensus and pricing history; and data containing broker information, estimates, guidance, sharp consensus, 
and more. For a guided tour of the All Estimates report, launch the eLearning demo on Online Assistant page 14898.

Click a report value and then select 
the "Broker Outlook" link to view the 
underlying broker estimates.  Depending 
on the value selected, you can launch 
additional reports including Surprise 
History, Estimate History, Consensus 
Trend, and more.

Click the "Next Report Date" link to view 
additional details, including consensus 
data and links to other FactSet 
Estimates reports.

View segment data, such 
as products or geographic 
segments generating sales 
and industry metrics (scroll) 
based on the company 
you've selected.  For more 
information on each, see 
Online Assistant pages 16932 
and 16038.

Click the Research Report 
icon to audit the data back 
to the source document.

Click the More Options 
button to access additional 
options, such as the type 
of estimate and estimate 
window.

Select report options from the 
toolbar, including the active 
identifier, display and period 
options, brokers (include/
exclude), currency, and more.

TIP > You can access FactSet Market 
Aggregates data in your estimate 
reports.  See Online Assistant page 
15316 for more details.

View Sharp Consensus data for 
additional insight on default 
consensus estimates. 

NOTE > This image was modified to remove restricted brokers.
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Viewing Credit Analysis Reports

The Debt Capital Structure (DCS) Overview report provides a broad and comprehensive overview of debt associated with an issuer.  It includes current credit ratings, credit spreads, a price and 
CDS history chart, historical credit analysis, debt capital structure summary, liquidity summary, and data for long-term debt by maturity and debt seniority. 

View the current credit 
rating and click a rating 
link (e.g., Ba1) to access a 
detailed long-term rating 
history for the issuer and 
related issuer ratings.

Hover over the Prices & 
CDS History chart to view 
the one-year and five-year 
CDS points, as well as the 
equity price of the issuer.

Track a company's maturity schedule and use the Maturity 
Type drop-down menu to select either an Aggregate, Issuer 
Breakdown, or As-Reported schedule.   You can also toggle 
between a table or chart view.  Scroll to view additional 
charts and data.

View a DCS summary or click the section link to launch the DCS Detail 
report, which provides a break down of instruments and line items that 
reconcile to the balance sheet debt values.  Within DCS Detail, you can click 
the Interim Activity button to view material changes since the last filing.

TIP > View an aggregate liquidity summary or click the “Liquidity 
Summary” section title to launch the Liquidity Detail report, which 
provides a detailed breakdown of individual revolving credit facilities. 
It includes a proprietary Liquidity Outlook indicator that provides a 
liquidity status (e.g., Stable, Positive, Negative) for an issuer.  For more 
information on the report, see Online Assistant page 15233.

Click a hyperlinked description to launch 
additional details with a link directly 
to the Security Overview report.  To 
learn more about the report, see Online 
Assistant page 15588.

Navigate to the other
Credit Analysis reports
using the tab’s left pane.
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Hover over each chart plot 
for a basic overview, then 
click an annotation for 
more details on how each 
campaign impacted stock 
performance. 

Click activist investor names 
to view position history and 
mutual fund ownership 
details. If subscribed, you can 
also quickly navigate to the 
Ownership 3.0 application. 
Click links in the Activism 
Level column to launch a 
snapshot of current and 
historical activism. 

Select an item from the 
drop-down menu to reveal 
each proposal topic or the 
pass/fail rates of proposals 
initiated by shareholders.

Adjust your perspective 
and switch between 
viewing a chart or table 
version of the activism 
data. 

Click the tile header links or 
View More Data buttons        to 
access additional information, 
such as specific holders and 
the change in number of shares 
held by each institution. 

Scroll up and down the 
report to identify state 
takeover laws, governance 
vulnerabilities, ISS 
QuickScores, and more. 

TIP > To learn more about all of 
the activism and governance 
reports available in the Activism/
Governance tab, start from Online 
Assistant page 20249.

Analyzing Corporate Activism 

Use the Corporate Activism report to access a thorough, all-inclusive picture of activism activity from the company perspective. Quickly view proxy fights, shareholder proxy proposals, and 
other activism campaign history.  Identify current activist holders in the shareholder base, governance strengths and weaknesses, and the relevant timing/deadlines for future activism threats. 
Powered by the FactSet SharkWatch database, the report also provides one-click navigation to key activist and campaign profiles.  
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Analyzing Ownership Data 

The Ownership tab provides institutional, mutual fund, and insider/stakeholder ownership information. It allows you to easily answer your basic Ownership questions and quickly dive into more 
detailed analysis.

Change the report type to see 
only institutions, institution/
insiders, mutual funds/ETFs 
or insiders for the selected 
equity.

TIP >  Read about the latest Ownership 
updates in the  "Company Analytics" category 
of FactSet Notify. Click the category's 
envelope icon to receive email alerts. 

Click the “Short Interest" or 
"Float" links to view additional 
historical details.

Click the link(s) in the 
Activism column (Medium 
and above) to view current 
and historical campaign 
activity.  Launch the Activist 
Profile report, which allows 
you to objectively evaluate 
the activism history and 
investment tactics of 
institutional investors.  For 
more details, see Online 
Assistant page 17828.

Click Company to view consolidated 
ownership across multiple share classes 
and stock issues at a company level. 

Add a watch list to your report by clicking 
the Watchlist button.  Select your existing 
watch list(s) or create a new one. 

Select the charted item, view 
the data table, or click the       
button to see more data.

Click the “Combined %OS” link 
to see what securities make up 
the company-level aggregate.

TIP >  You can also view three key ownership 
reports directly within the Company/
Security tab.  For more information on the 
reports, see Online Assistant page 17451.

Click holder links to view position history or 
mutual fund ownership details. You can also 
navigate to the Holder Summary report to 
view additional details.

Choose from a variety of 
company and holder reports in 
the left pane.
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Navigating the Deals Tab 

The Deals tab provides a comprehensive set of reports for analyzing deal terms, participants, and financials for M&A transactions. The Deals subtab includes reports on pending and closed 
transactions, while the Simulator subtab provides reports that allow you to view hypothetical deals between two public companies covered by FactSet Revere. 

ONLINE ASSISTANT PAGE ID 17262TO LAUNCH:  @MAD

The Deals tab includes the following reports:
• Snapshot: Provides a high-level overview of

the deal participants, key dates, financials, 
deal values/multiples, deal characteristics, 
advisors, and key documents. Learn more from
Online Assistant page 20759.

• Supply Chain Overlap: Exhibits overlapping
relationships between an acquirer and a target
company for a current deal. Learn more from 
Online Assistant page 20761.

• RBICS Overlap: Allows you to visualize the
revenue exposure of a newly formed entity by
sector and industry. Learn more from Online 
Assistant page 20762.

• GeoRev Overlap: Allows you to see where in the
world an acquirer and target company realize 
revenue.

• Price History: Provides key information for 
merger arbitrage and historical premium 
analysis, including participant stock price, offer
price, arbitrage spread, and premiums. Learn 
more from Online Assistant page 20763.

Select a recent M&A market transaction 
from the initial starter screen or search 
for a specific deal to get started.  To 
search for a deal, enter a deal identifier 
in the Identifier box or begin typing the 
companies involved, and then select the 
desired identifier to begin your analysis.

TIP > Read about the latest updates 
to the Deals tab in the "Company 
Analytics" category of FactSet 
Notify. Click the category's envelope 
icon to receive email alerts.

Choose the Simulator tab 
to help analyze target fit, 
new markets and shared 
customers, suppliers, 
and partners as a result 
of a hypothetical merger.
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Monitoring Market Data 

Monitor market data for securities, such as companies, indices, treasuries, currencies, futures, and commodities in the Market Watch display.  You can manually enter identifiers, open an 
existing ticker list, or view Universal Screening results.  To learn more about managing identifiers in Market Watch, see Online Assistant page 15884.

Click the Lookup button to select 
an identifier or type an identifier 
directly into the desired location. 

Right-click an identifier and 
select a report or market data 
display from the customized list 
to open and dynamically apply 
the identifier.

Double-click the N icon to view 
news for the identifier in the News 
display.

Double-click an identifier to apply 
the identifier to all the company-
specific displays in the tab.

Right-click and select Options > Groupings to apply 
groupings.  To create custom group headings, select 
a row and enter G:group_name for your securities.

Right-click and select "Options" to 
customize your columns using data 
from your FactSet subscription or 
your proprietary data.

Press the INSERT key to insert a row. 
Press the DELETE key to remove an 
identifier, group, or row.

Market Watch Hot Keys:
• To move around a Market Watch, press the Left and Right arrow keys

• To copy an identifier(s), press CTRL+C

• To cut an identifier(s), press CTRL+X

• To paste an identifier(s), press CTRL+V

• To select multiple identifiers, press CTRL or SHIFT

TIP > To manage real-time alerts that notify you if 
specific criteria are met for an identifier(s), use Alert 
Manager (@AM). For more information, see Online 
Assistant page 15873.

Click the drop-down arrow adjacent to the Lookup button 
and select "Open Screen Results" to access securities 
that pass a screen saved in Universal Screening.

Save your column layout and access 
it from the Layout drop-down menu.

TIP > Read about the latest updates to the Market 
Watch display in the "Real-Time Data and Displays" 
category in FactSet Notify.  Click the category’s 
envelope icon to receive email alerts.
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Managing Watchlists 

A watchlist is a group of identifiers that you want to monitor.  The Watchlist Editor lets you create these lists so you can quickly access the identifiers you're interested in within other 
applications, such as News and Calendar, without needing to re-enter the identifiers each time. 

Creating Watchlists
1. In FactSet Workstation, click the Watchlist Editor icon in the toolbar or enter the shortcut

@WLE in FactSet Search.  In FactSet Web, click the Create/Edit Watchlist button in the
left pane to launch Watchlist Editor. 

2. Type ticker, CUSIP, SEDOL, or security name into the Enter Symbols field.

(Optional) In addition to typing in tickers, you can copy identifiers from Microsoft Excel 
(.xls, .xlsx) or flat files (.txt, .csv) and then press CTRL+V to paste them into the aplication.   

3. Select the type of watchlist you want to create from the Watchlist Type drop-down menu.
You can choose to save as a list with Ticker Only, Ticker + Shares, or Ticker+Weight. 

4. (Optional) Fix unrecognized identifier(s). If the identifiers were exported from another 
program, it may differ from the symbology in FactSet.  Watchlist Editor will detect if there
are unrecognized symbols and then you can fix the unrecognized identifiers, click the 
Remove Invalid Symbols button to remove them or choose to keep them when saving.

5. Click the Save button           to save your watchlist.  Select the directory to save the
watchlist in and give it a name. The name cannot contain spaces or special characters. 
Your personal directory is accessible to only you while the client directory is used to share
files with your colleagues.

Managing Watchlists
Click     and select "Open"  to open an existing watchlist.  

To delete an identifier in your watchlist, hover your cursor over the symbol, and then click the 
Remove Row (X) button in the Watchlist Editor. 
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Accessing FactSet StreetAccount News 

 With real time, distilled market-moving information, FactSet StreetAccount gives you instant access to crucial intelligence for the companies and markets you care about.  Stay on top of market 
developments with stories and summaries written by industry professionals and pulled from all possible sources for corporate news. 

Easily filter your results to 
StreetAccount news for an 
individual company (as shown here) 
and find timely and informative 
news summaries.

Double-click on a 
headline to view the 
selected StreetAccount 
article, which provides 
the key points in a timely, 
succinct, and easy-to-
read format.

Access an earnings preview that provides the key consensus metrics an 
analyst should focus on when earnings are released.

View macro recaps around the clock for the U.S., European and Asian 
markets, including intraday market updates as shown below.

StreetAccount features the 
following content:
• Weekly and Week Ahead

Summaries

• M&A Summaries

• Earnings Focus (Preview, 
Recap, and Street Takeaways)

• Regulatory and Litigation
Details

• Corporate Actions and Key
Developments
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Searching Corporate Events and Transcripts 

Event Calendar allows you to view information for upcoming corporate events, economic releases, and IPOs.  The application includes transcripts, audio, presentation slides, IR contacts, and 
EPS/Sales consensus and actual figures for companies.

Type-ahead or enter a 
ticker to find events for 
a specific company.  You 
can also click the Lookup 
button to search for 
companies, portfolios,  
or indices.

Easily narrow your search 
-- click a specific day or the 
arrows to view a full week 
or month. Click the Today, 
Next 7, or Next 14 day 
buttons, or input a custom 
date range. The calendar 
saves the settings from 
your current work session.

Limit results by event type, 
region, and industry.  You 
can also include market 
holidays and your firm’s 
meetings.  

Click the event link to 
view event and company 
information, with links 
to additional documents 
when available.

Launch an audio file or 
download a transcript for 
an event by clicking the 
appropriate icon.

Click the Tools button 
to select your preferred 
file format, calendar 
notification options, time 
zone, and more.

TIP > Read about the latest updates 
to Event Calendar in the "Company 
Analytics" category of FactSet 
Notify.  Click the category’s envelope 
icon to receive email alerts.

Click an identifier to open the 
Single Company view, which 
provides transcripts for the 
company’s past events and 
details about future events.

Choose the Economic tab for timely event details, real-time data for 
the indicator and period covered in the release, forecasted or actual 
figures, the market median forecast, and more.

TIP > You can easily add 
upcoming events to your 
calendar by clicking the 
export icon         next to a 
future event.
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Use the report toolbar throughout the Markets tab to select a 
variety of options.  Based on the selected report, choose region, 
benchmarks, type of data to view, currency, dates and more.

Choose from the 
available output 
options, including the 
ability to print and 
download your report 
to Excel or PDF.

View sparklines to see a quick trend analysis 
and click it to see a larger version that includes 
the option to launch as an interactive chart.

Quickly switch between 
the various reports in 
the left pane, grouped by 
asset class.  The reports 
available may vary based 
on subscription.

Access common features 
throughout the Market 
reports, including the 
ability to single-click 
a linked item to view 
additional details and 
launch related reports.

TIP > Read about the latest updates 
to the Markets tab in the "Market 
Analytics" category in FactSet 
Notify.  Click the category's envelope 
icon to receive email alerts.

Performing Market Analysis 

The Markets tab offers an intuitive, streamlined solution for performing all of your market research within a single tab.  It includes a variety of reports on global markets, across multiple asset 
classes, including Equities, Fixed Income, Commodities, ETFs, and FX. 

View performance 
and valuation metrics 
from FactSet Market 
Aggregates throughout 
various reports.  Click 
the  button in the 
toolbar to adjust the 
columns included.

Select "Indices" within the Equity section in the 
left pane to see how different equity markets 
are performing around the world.
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Navigating the Economics Tab

Analyze global economic data within a single tab that features an intraday economic events calendar, as well as detailed reports for countries and regions.

Choose a subtab to focus your analysis:
• Calendar: recent and upcoming releases of

global key indicators

• Country/Region: detailed reports for a
specified country or region

• Comparison: comparable data for key
economic concepts across a large number
of countries

• Estimates: annual estimates for key
economic concepts for a country

• Policy Rates: current central bank
monetary policy rates from countries 
around the world, including both recent and
upcoming rate changes

Click links within the calendar to access more 
detailed information.  For example, from the 
Event Info dialog box, you can jump to the 
Economic Synopsis report for that country, view 
the data in chart or report format, and launch 
the website.

Choose the Country/Region tab 
to view a variety of economic 
reports for a specific country 
or region (e.g., debt issuance, 
national accounts, inflation). 
Select the Key Indicators 
report for an overview of major 
indicators.

Click on an indicator to view 
a quick chart, key dates, and 
launch additional reports for 
that series.

TIP > Read about the latest updates for the 
Economics tab in the "Market Analytics" category 
of FactSet Notify.  Click the category’s envelope icon 
to receive email alerts.

Use the left pane to specify the date/period for 
the report and to limit the calendar by specific 
economic indicators, regions, importance, or 
perform a keyword search for events. 
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Configuring and Installing FactSet’s Mobile Solutions 

Use FactSet’s mobile solutions to access the same global market information and company intelligence that you receive on your desktop. View news, charts, and other detailed company reports 
for a saved portfolio, watch list, or company.

Installing and Logging Into the FactSet App
1. Go to the Apple App or Google Play store and search for "factset."
2. Tap the FactSet or FactSet 3.0 (latest version) icon from the results, and then tap Get.

3. Double-click or tap Install to confirm the download, and then open the app.
4. After opening, enter your corporate email address or factset.net account and tap

Request Passcode to receive a temporary six-digit passcode. 

5. Enter the passcode to log into the app.

Enabling Portfolios and Watchlists on an iPad
For iPhone and Android users, you can manage portfolios/watchlists directly on your mobile 
device. For iPad users, you must first enable them by following the steps below.

1. Launch the Wireless Configuration utility in FactSet workstation using the shortcut @WIR.
2. Click the Add Portfolio/Watchlist/Benchmark button at the bottom of the listed files. 

3. Select the portfolios, watch lists, or index that you want to enable, and then double-click
on it or click the Add as Composite button. When finished, click the OK button.

• For portfolios, you can select a standard currency, benchmark, and grouping.  For
watchlists, you can select a currency.

For more information on enabling data on your iPad, see Online Assistant page 14889.

Using the App

See the following Online Assistant pages for more details on 
using the app:

• FactSet for Android and iOS phones - start on page 20015

• FactSet  for iPad - start on page 20691

The latest FactSet mobile app allows you to:
• Access global markets and company intelligence with real-time

market pricing, news, company reports, and charts

• View performance of your portfolios

• Maintain watchlists that seamlessly sync in real time

• Read market synopsis' and top news stories

• Receive alerts to stay informed on market and company events
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ONLINE ASSISTANT PAGE ID 1967

Building =FDS Codes 

=FDS is a Microsoft Excel function that dynamically pulls data stored on FactSet servers, allowing you to automatically update your spreadsheet data.  For a guided tour about building =FDS 
codes, launch the eLearning series on Online Assistant page 16644.

Benefits to building models with =FDS codes include:
• Allows FactSet data to be dynamically incorporated into an Excel model

• Uses Excel functionality, such as cell referencing

• Allows you to combine FactSet formulas with other Excel functions

Basic Syntax

=FDS("IDENTIFIER","DATA_ITEM(START_DATE,END_DATE,FREQUENCY)")

• Each code has two distinct parts: the security or index identifier and the formula of the
item being retrieved.  Both items are enclosed in quotation marks.

• You can write the identifier as an exchange ticker, such as XOM-US for Exxon Mobil
Corp., or a SEDOL, such as 0798059 for BP PLC.

• This syntax is the basic syntax for =FDS codes, but the arguments will vary based on
the formula you select.

Dates

=FDS codes accept both relative and absolute dates as formula arguments.  An absolute date 
is a specific point in time, while a relative date represents a date relative to the most recently 
updated period.

TIP > You can also mix absolute and relative dates using FactSet 
formulas. For example, entering 12/31/2020-2AW returns data as of 
two actual weeks (14 days) before the end of 2020.

Examples

Retrieves Exxon Mobil’s latest closing price =FDS("XOM-US","P_PRICE(0D)")

Retrieves BP PLC’s latest annual sales =FDS("0798059","FG_SALES(0)")

Date Frequency Options

D Daily AM Actual Monthly Y Fiscal Yearly

W Weekly Q Fiscal Quarterly CY Calendar Yearly

AW Actual Weekly CQ Calendar Quarterly AY Actual Yearly

M Monthly AQ Actual Quarterly RANGE [Between 2 dates]

Absolute Date Examples Relative Date Examples

Day (MM/DD/YYYY or DD/MM/YYYY): 
7/11/2020, 11/7/2020

Most recent trading day:  
0D

Month-end:  
6/2019, 4/2020, 1/2021

One trading day before the most recent trading day:  
-1D

Fiscal quarter-end: 
20/1F,  2020/3F

Seven days before the most recent trading day: 
-1AW

Calendar quarter-end: 
2021/1C, 2020/3C

Last trading day of the most recent week: 
0W

Semi-annual period-end: 
2020/1S, 2019/2S

Last trading day three weeks ago: 
-2W

Fiscal year-end: 
2020, 2019, 18

One actual month from most recent trading day: 
-1AM

Last trading day twelve months ago: 
-11M

Last trading day of the most recent fiscal year: 
0Y
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ONLINE ASSISTANT PAGE ID 16664TO LAUNCH:  MICROSOFT EXCEL > FACTSET RIBBON > INSERT FORMULA BUTTON

Using FactSet Sidebar 

FactSet Sidebar adds context and transparency to your data by allowing you to easily view a breakdown of values in a calculation, identify the data source, and access the full-text definition 
behind a formula using =FDS codes in the Detail tab. Use Sidebar to create and edit =FDS codes and FQL (^=) or Screening (^%) Data Downloading formulas in the Insert and Edit tabs.  For a 
guided tour of Sidebar, launch the eLearning series on Online Assistant page 16786.

Using Shortcuts in Sidebar:
• Show or hide Sidebar:

CTRL+M

• Switch focus between Excel and Sidebar:
CTRL+J

• Activate the Detail tab from Excel:
CTRL+T

• Activate the Detail tab within Sidebar:
ALT+D

• Activate the Insert tab within Sidebar:
ALT+I

• Activate the Edit tab within Sidebar:
ALT+E

• Insert a formula from the Insert tab:
ALT+N

• Modify a formula in the Edit tab:
ALT+M

• Cycle through the tabs in Sidebar:
CTRL+PAGE UP/DOWN

Launch FactSet Sidebar in Microsoft Excel 
by clicking the Insert Formula button 
or toggling the Show/Hide button in the 
FactSet ribbon.

Click the Settings button to manage hot keys in Sidebar, restore Sidebar 
to its default size and position, specify how you want to retrieve data 
on FactSet (using =FDS codes, or FQL or Screening Data Downloading), 
change your database order, and much more.

Positioning Sidebar in Excel
You can dock Sidebar on the left or the 
right side of Excel, undock the utility so it 
"floats" on top of Excel, or position Sidebar 
on a second monitor. To undock/dock, 
double-click Sidebar's title bar or simply 
drag the title bar.

FactSet Sidebar is context-sensitive and 
displays information for the formulas you've 
selected in Excel in the Detail tab. To edit an 
existing formula, select the data item and 
choose the Edit tab in Sidebar.

View the full-text definition for the item 
you've selected.

TIP > Read about the latest FactSet Sidebar 
updates in the "Office Integration" category 
of FactSet Notify.  Click the category's 
envelope icon to receive email alerts.

TIP > You can also use Sidebar in PowerPoint 
and Outlook.  For more information, see 
Online Assistant pages 17544 and 17466.
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ONLINE ASSISTANT PAGE ID 16772TO LAUNCH:  MICROSOFT EXCEL > FACTSET RIBBON > INSERT FORMULA BUTTON > INSERT TAB

Inserting Formulas 

Sidebar’s Insert tab streamlines the process of creating =FDS and FQL (^=) or Screening (^%) Data Downloading codes in Excel. The Insert tab features more targeted search results, type-ahead 
search functionality for identifiers, the ability to cell reference across Excel workbooks and worksheets, a real-time preview of your data in Excel, function-building capability, and much more. To 
insert a formula, choose the Insert tab in Sidebar or select “Insert Formula” from the Insert Formula drop-down menu within the FactSet ribbon in Excel.

If =FDS mode is selected in the Settings button of Sidebar, the 
Identifier section is displayed.  Enter a company's identifier or use 
type-ahead search to find it.  You can also click the Lookup button 
to search for an identifier. You can enter multiple identifiers at once.

Search for a formula using the Enter Keyword field. By default, 
you'll see a list of formula matches from all of the databases 
you subscribe to. You can organize your search results by 
selecting an option from the List drop-down menu.

You can limit your search results using the following buttons:
• FactSet Recommended       : click to view FactSet 

Recommended formulas 

• Favorites      : click to view formulas tagged as favorites

• Sources: click to specify the formula libraries to search through

In this example, a keyword search for EPS returns all EPS formulas 
from the FactSet Fundamentals formula library.

You can specify the report basis, date, frequency, currency, and 
other formula arguments that are specific to the data item you've 
selected using the drop-down menus or cell references. 

To cell reference an identifier or formula argument across 
Excel workbooks and worksheets, click the Select a Cell 
Reference button       .

After selecting an identifier and data item, the real-time 
preview in Excel shows you where the data will be outputted 
once you click the Insert button. To disable this feature, click 
the Settings button       and make your selection in the "Show 
data preview in Excel" drop-down menu.

Use the toolbar options in the Formula Workspace to help 
apply a function, build compound codes, undo/redo actions, 
and clear a code. You can also manually enter text when 
building your formula. To learn more about applying functions 
or building compound codes in Sidebar, see Online Assistant 
pages 16779 and 16880. 

Click the Insert button to output the data into your 
Excel spreadsheet.

Message Possible Issue Solution

#CALC Appears when an =FDS code 
is recognized by FactSet and 
is ready to be calculated

Recalculate the =FDS request 
code(s)

#NUM Appears when an =FDS code 
is missing arguments of has 
a syntax error

Double check the code for 
correct syntax

#VALUE Appears when you have an 
Excel calculation waiting 
for an =FDS code to be 
recalculated

Recalculate the =FDS request 
code(s)

#NAME Appears when Excel does 
not recognize the function

Check and correct spelling in 
=FDS request code(s)

#REF Appears when a cell 
reference is deleted

Relink all appropriate cell 
references used in =FDS 
request code(s)

Common Formula Messages in Excel
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ONLINE ASSISTANT PAGE ID 16675TO LAUNCH:  MICROSOFT EXCEL > FACTSET RIBBON > INSERT FORMULA BUTTON > DETAIL TAB

Viewing Formula Details 

Sidebar’s Detail tab helps you analyze data in Excel more efficiently by anticipating the information you need to know about selected =FDS codes. Within the Detail tab, you can quickly audit a 
FactSet formula back to the source document, understand the breakdown of the calculation, access additional company information, and more.

When a cell hasn't been refreshed to reflect the most 
current value for that formula, Sidebar provides a 
warning that the cell may need to be refreshed.

View a breakdown of the calculation for the formula 
you've selected in the Data item section.

FactSet Mergers subscribers can view key deal 
information as well as the deal's source documents 
in Sidebar's Detail tab to continue analysis without 
leaving Microsoft Excel.

FactSet Fundamentals subscribers can quickly audit 
data back to the source document to reconcile the 
values presented for increased transparency.

Launch overview reports for companies, benchmarks, 
bonds, countries, and many other entity types. This 
functionality provides a quick and easy way to get 
more information about a security or deal that you are 
analyzing in Microsoft Excel.



21Copyright © 2022 FactSet Research Systems Inc. All rights reserved.  |   support@factset.com

ONLINE ASSISTANT PAGE ID 509, 10126

Cell Referencing =FDS Codes 

You can use string concatenation to reference dates, which is an Excel feature that combines data or text from multiple cells into one cell. This allows you to do date math and reference different 
parts of the =FDS code.

Using Concatenation

Example

The price of XOM-US as of the date in cell A1:

=FDS("XOM-US","P_PRICE("&A1&")")

Syntax

Use the following syntax when creating an =FDS code with cell references:

=FDS(A1,"DATA_ITEM("&CELLREFERENCE&")")

Using Concatenation in Sidebar

Use string concatenation in Sidebar to easily add cell references to your =FDS codes.  Click the Select Cell Reference button       or type the cell reference (e.g., =A1) for the identifier or formula 
arguments.  See Online Assistant page 16772 for more information on inserting formulas using Sidebar.

Replace the date with the "&cellreference&": 

=FDS("XOM-US","P_PRICE(1/1/2021)")

Example:

=FDS("XOM-US","P_PRICE("&A1&")")

Use string concatenation with date math: 

=FDS("XOM-US","P_PRICE(1/1/2016+10D)")

Example:

=FDS("XOM-US","P_PRICE("&A1&"+10D)")
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ONLINE ASSISTANT PAGE ID 2166

Retrieving Time Series Data 

You can use =FDS codes to calculate a time series of data in Excel. To use an =FDS code to retrieve multiple points in time, you need to build an array.  An array tells Excel where in the report to 
place the data.  To calculate a time series, you need to select a start date, end date, and frequency.  

To manually modify an array:

1. Highlight the number of cells in your new array.  You can highlight either across the
row or down the column.

2. Press the F2 key to activate the cell with the range still highlighted and edit the
=FDS code.

3. Press the following keys simultaneously: CTRL+SHIFT+ENTER.

To create an array in Sidebar:

1. Select the cell where you want your time series of data to begin.
2. Choose the Insert tab in Sidebar and search for or enter the cell reference for your

identifier in the Identifier section.
3. Search for and select your formula in the Data Item section.
4. Enter the start date, end date, and frequency for your array within the Inputs

section.

TIP > You can also easily edit an array of data using Sidebar.  To edit, select any 
part of the array, and then choose the Edit tab in Sidebar.  Adjust the arguments 
as desired and click the Modify button.
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ONLINE ASSISTANT PAGE ID 16773TO LAUNCH:  MICROSOFT EXCEL > FACTSET RIBBON > INSERT FORMULA BUTTON > EDIT TAB

Editing Formulas in Sidebar

Sidebar’s Edit tab allows you to edit existing =FDS codes and FQL (^=) or Screening (^%) Data Downloading formulas, including compound codes. You can shorten or lengthen a time series, 
change the selected data item, modify formula arguments, or add a function. For a guided tour on editing a formula or applying a function in Sidebar, launch the eLearning demo on Online 
Assistant page 16786.

1. Select the data item you'd like to edit in Excel 
and choose the Edit tab in Sidebar. If Sidebar isn't
already launched, right-click on the data item and 
select FactSet > Edit Formula.2. Within the Data Item section, you can change 

the formula by typing a keyword or phrase in the 
Enter Keywords box and pressing ENTER. To learn
more about the formula, expand the Definition 
section to view the formula name, data source, 
and definition.

3. If you're editing an =FDS code, you can change 
the company identifier(s) in the Identifier section.

4. Modify formula arguments you previously 
specified in the Inputs section. For example, you
can shorten or lengthen a time series, or change 
the currency, date alignment, and units.

5. Once you've modified the data item, you 
can apply or remove a function in the Formula
Workspace section by clicking the Function
button       . 

6. Click the Modify button to apply the changes
you've made to the formula in Excel.

TIP > Edit all of the common inputs of a 
compound code at once in Sidebar's Edit 
tab. Any changes are applied to all portions 
of the code. For example, when you change 
the frequency and currency arguments, the 
updates are applied to both formulas in the 
compound code.

TIP > You can create and edit custom screening 
(%) formulas in Sidebar. To learn more about 
working with custom formulas, see Online 
Assistant page 17318.

23
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ONLINE ASSISTANT PAGE ID 16779

Applying Functions and Performing Calculations

Functions and Sidebar
You can use Sidebar to easily add functions to formulas in your templates.  The following 
walks you through an example of how to add a function using Sidebar.
To build the average exchange rate formula using Sidebar:

1. Select the cell where you want to add your code.
2. Search and select the desired exchange rate formula in the Data Item section.
3. Enter your formula arguments.
4. Expand the Formula Workspace section.
5. Click the Function button to launch the Functions Search dialog, which lists the most

commonly used functions. 

6. Select "AVG - Average" from the list and click the Apply button.  The function is then
added to your Formula Workspace. 

7. Click the Insert button to add the formula to your template.

Calculations and Sidebar
Within the Formula Workspace section, select the part of the formula where you want to 
add an operator. Click the Operator button         and choose the operator. (You can also type 
directly into the workspace.)

Statistical Functions
Statistical functions calculate statistics on groups of numbers.  All statistical functions 
ignore non-available data.

Example
The following code returns the average exchange rate between U.S. dollars and euros for 
the last year.

=FDS("XOM-US","AVG(P_EXCH_RATE(USD,EUR,-1AY,0D,D))")

Logical Functions
Logical functions let you test various conditions before including a value in a report and are 
useful for dealing with non-available data. An IF statement is a common logical function 
that returns a designated value if the test condition is true and returns a different value if 
the test condition is false.

Example
The following code returns the word UP if the one-day price change is greater than zero and 
returns the word DOWN if the one-day price change is less than or equal to zero.

=FDS(A1, "IF(P_PRICE_CHANGE(0D,-1D)>0, ""UP"",""DOWN"")")

Performing Calculations
You can use =FDS codes to produce ratios on the fly by dividing one FactSet formula by 
another (e.g., Enterprise Value divided by Sales). 

Example
The following code calculates Enterprise Value to Sales for BP PLC as of the latest com-
pleted fiscal year.

=FDS("BP-GB","FF_ENTRPR_VAL(ANN,0Y,,,RF)/FF_SALES(ANN,0Y,,,RF)")
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Using Spreadsheet and Modeling Tools 

FactSet’s Spreadsheet Tools help reduce the amount of time needed to create, format, and audit Microsoft Excel spreadsheets.  For a guided tour on using any of the Productivity Suite tools, 
launch the eLearning series on Online Assistant page 16170. 

ONLINE ASSISTANT PAGE ID 15415TO LAUNCH:  MICROSOFT EXCEL > FACTSET RIBBON

Quickly apply your company's chosen 
styles from the drop-down menu or 
with single a keystroke.  You can apply 
colors to inputs, formulas, links, and 
more.  

For example, highlighting the area, and 
then selecting AutoColor Selection or 
pressing CTRL+ALT+A adds the proper 
color and formatting to the tables and 
charts selected in the spreadsheet as 
shown below.

Use StyleCycles to apply formatting 
options based on your firm's 
branding (e.g., font color, decimal 
format, currency, borders).  For 
tables, you can define the interior 
style, top row, bottom row, and more.  

Customizing StyleCycles
To customize StyleCycles, go to Settings > Spreadsheet Tools, and then choose 
the StyleCycles tab.  Select formatting options from the Available Styles 
section (right) and click the Add button to add them to the Styles in SmartCycle 
section (left). Click the New button to view extended formatting options.

Example StyleCycles:

Currency CTRL+SHIFT+$
Date CTRL+SHIFT+@
Percent CTRL+SHIFT+%
Multiple CTRL+SHIFT+*
Font Color CTRL+ALT+Z
Underline CTRL+SHIFT+U
Centering CTRL+SHIFT+C
Borders CTRL+SHIFT+B
Row Height ALT+SHIFT+ PageUp
Cell Color ALT+SHIFT+K
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ONLINE ASSISTANT PAGE ID 15415TO LAUNCH:  MICROSOFT EXCEL > FACTSET RIBBON

TIP > You can practice by opening 
the Spreadsheet Tools Examples 
Workbook and use all of the Hot 
Key and StyleCycle combinations 
available in Excel.  

From the FactSet ribbon, select 
Help > Spreadsheet Tools Example 
Workbook.

Smart Precedents CTRL + SHIFT + {
Smart Dependents CTRL + SHIFT + }
AutoColor: Automatically color-code cells either on entry or by using the below key stroke

AutoColor a selection CTRL + ALT + A

AutoColor a whole worksheet CTRL + ALT + S
AutoColor an entire workbook CTRL + ALT + Q

Error Checking:  Toggle a custom =IF(ISERROR message in case of NAs
Check for Errors CTRL + SHIFT + E

Increase Decimal CTRL + .
Decrease Decimal CTRL + ,
Smart Copy:  Copy inputs and formulas across a range using a single keystroke. Smart Copy determines 
the appropriate range and adjusts formulas automatically if there are irregularly spaced columns

Smart Copy Right CTRL + SHIFT + R
Smart Copy Down CTRL + SHIFT + D

Using Spreadsheet and Modeling Tools 

FactSet’s Spreadsheet Tools provide over 160 hot keys.  The following key combinations allow you to save time by skipping multiple mouse clicks to perform common actions in Excel.  You can 
also set additional options for select hot keys in the General tab of the Spreadsheet Tools - User Settings dialog box as described below.  Additionally, you can use the Hot Key Manager (FactSet 
ribbon > Settings > Manage Hotkeys) to view, reassign, or customize preferred key combinations.  

Essential Hot Keys

You can use a variety of hot 
keys to more efficiently manage 
spreadsheets and models.  For 
example, you can use hot keys 
to quickly audit cells and view 
either precedents for, or cells that 
are dependent on, the cell you've 
selected by using the hot key 
combination CTRL+SHIFT+{ as 
shown in the table above.

Click on each precedent link to quickly 
view the cell that feeds into the 
selected formula and click the Return 
button to go back to the original cell.
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Viewing Filings in the Company/Security Tab 

The Filings report accessible from the Company/Security tab, allows you to quickly find and analyze filings and exhibits for a company or security. Filings and exhibits display in groups or tiles of 
like documents for easy navigation. 

ONLINE ASSISTANT PAGE ID 21065TO LAUNCH:  COMPANY/SECURITY TAB > FILINGS

Perform a text search 
using Boolean syntax. 
Click the      icon to find 
examples of operators for 
making your queries easy 
and precise.  

Email, print, or send 
multiple documents 
to Drive. You can also 
download documents 
to Microsoft Word, 
PDF, and HTML.

Click on any headline to launch the filing in Viewer. 
Alternatively, hover your cursor over a headline to 
view a full document title.

Select any two EDGAR 
filings, and click 
Blackline Now to 
create a comparison 
report that highlights 
text changes. For more 
information, see Online 
Assistant page 14503. 

Add a company or security 
identifier. View filings 
grouped by document in 
easy-to-navigate tiles. 

Click Filings Wizard to 
download financials to 
Excel for multiple identifiers 
and fiscal periods.

Click More to display 
additional headlines.

Click an Excel icon to 
download tables of a 
particular period into 
Microsoft Excel.

Click the Chronological View 
icon to view documents in a 
list. Click the Exhibits icon 
to view exhibits.

Click the Key Filings icon 
to turn off the filter for 
key filings and view all 
documents from all sources.
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Viewing Historical Tables in Filings 

The Filings report in the Company/Security tab also allows you to quickly view and download historical versions of a table from any EDGAR filing. View any current financial table in an EDGAR 
filing and compare it to a prior historical version of the table side by side.  Copy a table or selected text and create shareable links to audit back to the source document. 

ONLINE ASSISTANT PAGE ID 21065TO LAUNCH:  COMPANY/SECURITY TAB > FILINGS

Click the Historical Tables button above 
a given table to view historical versions 
of that same table side-by-side.

Create a link to any table to share with 
a colleague or copy an entire table to 
paste into Microsoft Excel.

Share data by highlighting specific content 
in a filing and clicking the "Create URL" 
option to create a hyperlink that leads 
directly to the text you selected in the filing.

Export any or all tables to Excel 
by clicking the Download and 
Download All buttons.
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ONLINE ASSISTANT PAGE ID 17511TO LAUNCH:  MICROSOFT EXCEL > FACTSET RIBBON > SOURCE DOCUMENTS BUTTON

Using Source Document Manager 

The Source Document Manager is a fully functioning, standalone Internet browser that links data between Microsoft Excel and either PDF or HTML files with audit trails back to source filings.  
Once open, navigate to a PDF or a static HTML page (e.g., Edgar filings), use the Getting Started page to find or search for a filing, or click the Open button to access files you have stored locally.  
For a guided tour on linking items using the Source Document Manager, launch the eLearning demo on Online Assistant pages 16170.

Export individual pieces of 
data, whole tables (shown), 
or paragraphs using the 
sections in the sidebar.

Filter your export items by 
keyword, table size, number 
format, and more.

Quickly navigate through 
the document using your 
keyboard arrows or the 
Previous and Next buttons. 
Then, export the data to Excel 
by pressing ENTER or clicking 
Send to Excel.

After downloading to Excel, click on a 
linked value in Sidebar to open Source 
Document Manager and return directly 
to the original source file.

Quickly link to a different value 
by clicking the Edit button.

Find standard browser 
features like tabs and 
favorites in the toolbar.

TIP > Read about the latest 
Source Document Manager 
updates in the "Office 
Integration" category of 
FactSet Notify. Click the 
category's envelope icon to 
receive email alerts.

TIP > If a link breaks, the Edit button 
will be replaced with a Restore button 
in Sidebar for easy link repair.

Create context links for 
specific text or numbers by 
clicking on a value.  The Export 
to Excel section in the left 
pane will change to the "Text/
Number" option and provide 
the available export settings.

Click the Open button to 
open and link to a local HTML 
or text file.
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Using Filings Wizard 

Use the Filings Wizard to search for and download financial tables across companies and periods. Comprehensive coverage of all EDGAR filers plus over 30,000 companies is available for 
searching and downloading. You can quickly insert EDGAR 10K and 10Q tables into Microsoft Excel and audit back to those tables/filings in FactSet Workstation and Web. You can access the 
Filings Wizard in Excel (FactSet ribbon > Filings Wizard button), as well as FactSet Workstation and Web (@FW and Company/Security tab > Filings > Filings Wizard button).

ONLINE ASSISTANT PAGE ID 14237TO LAUNCH:  MICROSOFT EXCEL > FACTSET RIBBON > FILINGS WIZARD BUTTON

Enter a company's 
identifier to get started.  
You can choose to select a 
primary company, multiple 
comps, or a portfolio/
watchlist. Click the drop-
down menu to select which 
companies to include.

Select the periods and 
types of statements to 
include in your search.

Select which of the filings 
you want to download and 
view key details, including 
the fiscal period and date 
for each report.

Choose the desired layout 
and download options, as 
well as the display order 
for your table.

Preview the tables available 
for the selected period. You 
can then search the table 
and navigate to specific 
tables in the preview pane.

Click the Download 
button to download 
the tables to Excel.

Once the table(s) are 
downloaded to Excel, you 
can click the links to view the 
complete filing in FactSet 
Workstation or Web.
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ONLINE ASSISTANT PAGE ID 15418TO LAUNCH:  MICROSOFT POWERPOINT > FACTSET RIBBON

Using Presentation Linking and Formatting 

Presentation Linking and Formatting helps you quickly assemble presentation-quality documents and slideshows by sending updateable tables, text, pictures, and charts from Excel to 
PowerPoint and Word. The following shows you some of the key FactSet functionality available within PowerPoint.  For a guided tour on using any of the Productivity Suite tools, launch the 
eLearning series on Online Assistant page 16170.

To link items and import data 
from Excel to PowerPoint, 
highlight the region in Excel 
that you want to include in 
your presentation.  Right-
click in Excel, and then select 
"Export to PowerPoint" and 
your desired export option. 
For example, select Export to 
PowerPoint > Table as Picture.

You can quickly identify 
any items that are linked 
from Excel using Sidebar in 
PowerPoint.  For example, 
selecting "Linked Picture" 
highlights the table that 
was linked as a picture from 
Excel. 

Additionally, you can see 
the FactSet formulas and 
ActiveGraphs included in 
your presentation by clicking 
the links in the Detail tab.

Click the Show or Hide 
button in the FactSet ribbon 
to display Sidebar.  To learn 
more about Sidebar in 
PowerPoint, start from Online 
Assistant page 17544.

Managing Links and Switching Source Files
Use the Linked Items Wizard to update, edit, or view the source of linked items, even if the data comes from different Excel files. The following shows how to 
access the Linked Items Wizard from PowerPoint (Manage Links > Manage Excel Links).

TIP >  Click the Edit Source 
button in the Linked Items 
Wizard to save a version of 
a linked file with a different 
name.

TIP >  If you make changes or 
refresh the data in your Excel 
file, you can update individual 
items in PowerPoint by 
right-clicking and selecting 
"Refresh Excel Links."  To 
refresh all items, click the 
Refresh button in the FactSet 
ribbon and select "Refresh all
Excel Links." 
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Using Presentation Linking and Formatting

Changing the Settings for Linked Items or Imported Data 
In PowerPoint, choose the FactSet ribbon > Settings > Presentation Linking and Formatting. 

Choose the Import tab to modify 
the scaling, position, and other 
settings that display linked 
items within PowerPoint.

Assign a specific color to 
all imported cells for easy 
identification using the  
Colors tab.

Managing the Excel Model Versions
When you save Excel files with the same root name and in the same file path, PowerPoint 
will recognize if a newer version of the model exists. Choose to update the data from the 
selected file or from the original file.

TIP > Read about the latest 
updates to Presentation 
Linking and Formatting in 
the "Office Integration" 
category of FactSet Notify. 
Click the category's envelope 
icon to receive email alerts.

ONLINE ASSISTANT PAGE ID 15418TO LAUNCH:  MICROSOFT POWERPOINT > FACTSET RIBBON

For higher quality images, 
FactSet recommends selecting 
"printer" view format for 
both tables and charts when 
importing as pictures from Excel. 

Viewing Linked Items in PowerPoint
To access a linked item or imported data from PowerPoint, choose the FactSet ribbon > 
Manage Links > View Excel Link Source. You can also right-click the item and select "View 
Excel Link Source."  This will open the Excel file if not open already and will highlight the 
cell/table/chart to show exactly where the linked/imported data originates.

NOTE > Linked items keep files small and stable. You control when to 
update the exported items. 
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Inserting Company Logos 

You can search, verify, and insert company logos sourced from Clearbit directly in Microsoft PowerPoint.  To learn more about the company logo functionality, see Online Assistant page 22062.

ONLINE ASSISTANT PAGE ID 22062TO LAUNCH:  MICROSOFT POWERPOINT > FACTSET RIBBON > INSERT LOGOS

Click Insert Logos from the Shape Formatting 
section in the FactSet ribbon or press ALT+C+K 
to launch the Insert Company Logos dialog box.

Use the type-ahead search in the Identifier box to 
search by company name or ticker to select the 
appropriate identifier, and then verify the accuracy 
of the logo by visiting the company's website.

Click the Insert 
button to add the 
logo to the selected 
PowerPoint slide. 

TIP > Company logos are best used in conjunction with 
FactSet’s Shape Tools in PowerPoint to help save time 
formatting and aligning logos. 
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Using Shape Tools in PowerPoint 

Additionally, you can save time formatting and aligning shapes using FactSet’s shape tools. For more information on the shape tools available, see Online Assistant page 21984.  

ONLINE ASSISTANT PAGE ID 21984TO LAUNCH:  MICROSOFT POWERPOINT > FACTSET RIBBON > SHAPE TOOLS

Step 1: After adding logos and other shapes in PowerPoint, you can 
easily organize them by aligning each or adding them to a table. To align 
to a table, select Shape Tools > Align to PowerPoint Table Row/Column.

Step 2: Choose from the available options to align 
the shapes.

To change where you want to begin the alignment, 
drag the slider to select the desired row or 
column.

If there is more than one table in the selected 
slide, you can click the Change Table button to 
select a different table.

Step 3: Click OK to 
quickly align the logos 
in the selected table.

In addition to aligning 
to tables, you can 
automatically format 
and rearrange shapes 
in PowerPoint in 
a variety of ways, 
including rearranging 
shapes in a group 
and automatically 
formatting shapes to 
a grid.  After adding 
shapes, you can use 
the swap options to 
change the order of the 
formatted shapes.
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Creating an ActiveGraph 

Use ActiveGraph to create easy-to-update, pitchbook-ready financial graphs in Microsoft Word, PowerPoint, and Excel. ActiveGraphs are customizable and allow you to use your firm’s corporate 
colors, fonts, and standards. For a guided tour on creating ActiveGraphs, launch the eLearning series on Online Assistant page 14796. 

ONLINE ASSISTANT PAGE ID 14514TO LAUNCH:  MICROSOFT WORD/EXCEL/PPT > FACTSET RIBBON > ACTIVEGRAPH

After launching ActiveGraph, choose the 
type of chart you want to create and click 
the Next button.  Then, enter an identifier(s) 
or use type-ahead searching to search for 
and select an identifier to get started.

While entering inputs, view a real-
time preview of your graph in the top 
pane. Right-click and select "Format" 
to change the graph's colors, titles, 
legend, or axes.

Select a time period, frequency, and other 
common inputs for your graph.  The options 
available will vary based on the type of 
chart selected.

Click the Charts button to select a 
different graph category and type (e.g., 
Price, Valuation, Estimates, Profitability).  
Additionally, you can open an existing chart 
or save your current chart.

Click OK to insert the graph in Word, 
PowerPoint, or Excel.

Click the Reference Manager  
button          throughout ActiveGraph 
to reference identifiers, formulas, 
dates, and frequencies. To learn more 
about Reference Manager, see Online 
Assistant page 12169.

TIP > You can use Sidebar’s Detail tab 
within Excel and PowerPoint to load 
contextual information about a selected 
ActiveGraph. This includes auditing back to 
the source document and a range of links 
to FactSet reports for further research.

Click the Add Series button to add another 
series to your chart, including statistical 
lines (e.g., an average or median), financial 
items, or ratios (e.g., broker ratings, P/E 
ratio).

Click the Annotations button to quickly 
add dynamic annotations to your graph.  
Learn more about custom annotations 
on the following page.  Additionally, 
click Advanced Options to select 
spinoff, split , and calendar settings.

Select a StyleSet to change the style of your charts.  
StyleSets are document templates and can be created to your 
company’s specifications, allowing you to use your corporate 
identity in ActiveGraph.  For more information on setting up 
custom StyleSets, contact your FactSet representatives.
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Customizing Data in ActiveGraph 

You can add custom annotations to price graphs, indexed price graphs, and any line graphs within the ActiveGraph wizard. Custom annotations are useful for highlighting notable company 
events or news stories. 

ONLINE ASSISTANT PAGE ID 15544, 14554TO LAUNCH:  MICROSOFT WORD/EXCEL/PPT > FACTSET RIBBON > ACTIVEGRAPH

If your graph contains more than one 
series, select the appropriate series 
from the drop-down menu to add custom 
annotations.

Click the Categories button to choose one 
or more annotation categories from the 
drop-down menu. To display any desired 
annotations on the graph, select the 
corresponding check box.

Double-click a column heading to sort the 
data in ascending or descending order.

Click the News button          to find all 
related news headlines for a specific 
event.   Click a headline link to launch the 
article within Viewer.  Select a headline’s 
corresponding check box to display that 
annotation in the chart. 

TIP >  Read the latest ActiveGraph updates 
in the "Office Integration" category 
of FactSet Notify.  Click the category’s 
envelope icon to receive email alerts.

After adding annotation headlines to your 
chart, you can edit the annotation, move, 
or format it further from the interactive 
preview.

Click within the "Event Descriptions" field 
to edit the annotation text.
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